Bristol OpenEnterprise Reference Guide
Database Explorer
## Contents

1 Database Explorer View ........................................................................................................................................ 7

2 Database Explorer Interface .................................................................................................................................. 8
   2.1 Database Tree View Pane .................................................................................................................................. 8
       2.1.1 Opening the Database tree .................................................................................................................. 9
       2.1.2 Tables .................................................................................................................................................. 9
       2.1.3 Views .............................................................................................................................................. 9
       2.1.4 Quickly Viewing all Objects in a selected Table ................................................................................ 9
       2.1.5 Context Menus .................................................................................................................................. 10
       2.1.6 Database Context Menus .................................................................................................................... 10
           2.1.6.1 Database Context Menu ........................................................................................................... 10
           2.1.6.2 Connect .................................................................................................................................... 11
           2.1.6.3 Disconnect ............................................................................................................................... 11
           2.1.6.4 Remove From Hierarchy ........................................................................................................... 11
           2.1.6.5 Search for Table ........................................................................................................................ 11
           2.1.6.6 Search for Attribute .................................................................................................................... 11
           2.1.6.7 Search for Primary Key Attribute .............................................................................................. 11
           2.1.6.8 Search for Owned Tables .......................................................................................................... 11
       2.1.7 Table Context Menus ................................................................................................................................ 11
           2.1.7.1 Search for Attribute .................................................................................................................... 12
           2.1.7.2 Search for Primary Key Attribute .............................................................................................. 12
           2.1.7.3 Configure Content ..................................................................................................................... 12
       2.2 Tables Pane ................................................................................................................................................ 12
           2.2.1 Tables Pane Details Mode ................................................................................................................ 12
           2.2.2 Tables Pane Context Menu ............................................................................................................ 13
               2.2.2.1 Search for Attribute ................................................................................................................ 13
               2.2.2.2 Search for Primary Key Attribute .......................................................................................... 13
               2.2.2.3 Configure Content ................................................................................................................ 13
               2.2.2.4 Down One Level .................................................................................................................... 13
               2.2.2.5 Up One Level ........................................................................................................................ 13
               2.2.2.6 Help ....................................................................................................................................... 14
       2.3 Attributes Pane ........................................................................................................................................... 14
           2.3.1 Attributes Pane Details Mode ........................................................................................................ 14
           2.3.2 Attributes Pane Context Menu ...................................................................................................... 14
       2.4 Menu Bar .................................................................................................................................................... 15
           2.4.1 File Menu ........................................................................................................................................ 15
               2.4.1.1 Add Database Dialog .............................................................................................................. 15
               2.4.1.2 Database Address Definition .................................................................................................. 16
                   2.4.1.2.1 Defining the DNS Address ............................................................................................... 16
                   2.4.1.2.2 Defining the Data Service Name ..................................................................................... 16
               2.4.1.3 Connect All ................................................................................................................................ 16
               2.4.1.4 Disconnect All ........................................................................................................................ 16
               2.4.2 View Menu ................................................................................................................................... 17
Database Explorer

2.4.2.1 View Toolbar .............................................................................................................................. 17
2.4.2.2 View Status Bar Menu Item ................................................................. 17
2.4.2.3 Large Icons .............................................................................................................................. 17
2.4.2.4 Small Icons .............................................................................................................................. 17
2.4.2.5 List ........................................................................................................................................... 18
2.4.2.6 Detail ........................................................................................................................................ 18
2.4.2.7 Down One Level ................................................................................................................ 18
2.4.2.8 Up One Level ...................................................................................................................... 18
2.4.2.9 Database Object Viewer ................................................................................................. 18

2.4.3 Options Menu ............................................................................................................................ 18
2.4.3.1 Content Attributes ........................................................................................................... 18
2.4.3.1.1 Set All Button ................................................................................................................. 19
2.4.3.1.2 Clear All Button ............................................................................................................... 19
2.4.3.1.3 Include String ................................................................................................................ 19
2.4.3.1.4 Include Bool .................................................................................................................. 19
2.4.3.1.5 Include Integer .............................................................................................................. 19
2.4.3.1.6 Include Real .................................................................................................................... 19
2.4.3.1.7 Include Time Date ........................................................................................................ 19
2.4.3.1.8 Include Primary Key ..................................................................................................... 20
2.4.3.1.9 Include Foreign Keys .................................................................................................. 20
2.4.3.1.10 Include Not Keys ........................................................................................................ 20
2.4.3.1.11 Include Nullable ........................................................................................................ 20
2.4.3.1.12 Include Not Nullable ................................................................................................. 20
2.4.3.1.13 Include Persistent ....................................................................................................... 20
2.4.3.1.14 Include Not Persistent ............................................................................................... 20
2.4.3.1.15 Include Hidden .......................................................................................................... 20
2.4.3.1.16 Include Not Hidden .................................................................................................. 20
2.4.3.2 Default DBX Files ............................................................................................... 20
2.4.3.2.1 DBX File Location ................................................................................................. 21
2.4.3.2.2 Browse Button ........................................................................................................... 21
2.4.4 Window Menu .......................................................................................................................... 21
2.4.4.1 Open DOV Windows ............................................................................................ 21
2.4.4.2 Close All Windows ....................................................................................................... 22

2.4.5 The Help Menu ......................................................................................................................... 22
2.5 The Status Bar ............................................................................................................................. 22

2.6 Toolbar ...................................................................................................................................... 22
2.6.1 Database List ........................................................................................................................ 23
2.6.2 Up One Level Button ....................................................................................................... 23
2.6.3 Add Database Button ........................................................................................................ 23
2.6.4 Open DOV Button ............................................................................................................... 23
2.6.5 Large Icons Button .......................................................................................................... 23
2.6.6 Small Icons Button .......................................................................................................... 23
2.6.7 List Button ........................................................................................................................ 23
2.6.8 Details Button .................................................................................................................. 23
3 The Database Object Viewer

3.1 File Menu
   3.1.1 New
   3.1.2 Open
   3.1.3 Close
   3.1.4 Save
   3.1.5 Save As
   3.1.6 Run
   3.1.7 Exit

3.2 Options Menu
   3.2.1 Read Only
   3.2.2 Active Query
   3.2.3 Custom Data String
   3.2.4 Tag Format
      3.2.4.1.1 OPC
      3.2.4.1.2 DDE
   3.2.5 Printer Properties
   3.2.6 Display Properties
      3.2.6.1 Background Color
      3.2.6.2 Foreground Colour
      3.2.6.3 Color Browse Buttons
      3.2.6.4 Hide Column Headings
      3.2.6.5 Disable Message Boxes
   3.2.7 Exit

3.3 Query Menu
   3.3.1 Apply
   3.3.2 Stop

3.4 Help Menu

3.5 DOV Status Bar

3.6 The DOV Toolbar
   3.6.1 New Query
   3.6.2 Open Query
   3.6.3 Close Query
   3.6.4 Save Query
   3.6.5 Save As
   3.6.6 Run a Saved Query
   3.6.7 DOV Up One Level
   3.6.8 Menu Editor
   3.6.9 Run Current Query
   3.6.10 Active Query Button

3.7 Tables Tab
   3.7.1 Available Tables Pane
   3.7.2 Add Button
   3.7.3 Remove Button
   3.7.4 Selected Database
   3.7.5 Selected Tables

3.8 Conditions Tab
3.8.1 Auto Run Without Conditions ................................................................. 31
3.8.2 Add Attribute Button ........................................................................... 31
3.8.3 Update Query Button ........................................................................... 31
3.8.4 Remove Condition Button ................................................................... 31
3.8.5 Condition Edit Field ............................................................................ 32
3.8.6 Edit Attribute Button ........................................................................... 32
3.9 Parameters Tab .......................................................................................... 32
3.9.1 Parameter Name ................................................................................... 33
3.9.2 Parameter Definition ............................................................................ 33
3.9.3 Parameter List ........................................................................................ 33
3.10 Joins Tab ................................................................................................... 33
3.10.1 Attributes Available for Join Statement .............................................. 34
3.10.2 Add Join Button .................................................................................. 34
3.10.3 Remove Join Button ............................................................................ 34
3.10.4 Joins List ............................................................................................... 34
3.11 Attributes Tab .......................................................................................... 34
3.11.1 Available Attributes .......................................................................... 35
3.11.2 Add Attributes Button ........................................................................ 35
3.11.3 Remove Attributes Button ................................................................. 35
3.11.4 Remove All Attributes Button ............................................................ 35
3.11.5 Selected Attributes List ...................................................................... 35
3.11.6 Toggle Attribute Display ..................................................................... 36
3.11.7 Row or Cell Selection Buttons ............................................................ 36
3.11.8 Row Selection ...................................................................................... 36
3.11.9 Cell Selection ....................................................................................... 36
3.11.10 Dynamic Sort .................................................................................... 36
3.11.11 Sort Column ...................................................................................... 36
3.11.12 Sort Ascending .................................................................................. 36
3.11.13 Active Query Support ....................................................................... 36
3.12 SQL Tab ..................................................................................................... 36
3.12.1 SQL Statement Field .......................................................................... 37
3.12.2 Edited Button ....................................................................................... 37
3.12.3 Generated Button ............................................................................... 37
3.13 Filter Tab ................................................................................................... 37
3.13.1 Include String ..................................................................................... 38
3.13.2 Include Bool ....................................................................................... 38
3.13.3 Include Integer ................................................................................... 38
3.13.4 Include Real ....................................................................................... 38
3.13.5 Include Time Date ............................................................................. 38
3.13.6 Include Primary Key .......................................................................... 38
3.13.7 Include Foreign Keys .......................................................................... 39
3.13.8 Include Not Keys ................................................................................. 39
3.13.9 Include Nullable ................................................................................. 39
3.13.10 Include Not Nullable ........................................................................ 39
3.13.11 Include Persistent .............................................................................. 39
3.13.12 Include Hidden ................................................................. 39
3.13.13 Include Not Hidden ............................................................ 39
3.14 Time Zone Tab ........................................................................ 39
  3.14.1 Use Time Zone Button ....................................................... 40
  3.14.2 Time Zone List ................................................................. 40
3.15 Objects Tab ............................................................................. 40
  3.15.1 Queried Objects List .......................................................... 41

4 Index .............................................................................................. 42
1 Database Explorer View

The Database Explorer component, including Database Explorer (DBE) and Database Object Viewer (DOV) provides a graphical interface to the schema of any available OpenEnterprise (OE) Servers.

It allows a user to:-

- Explore OpenEnterprise database structures
- Build static or dynamic SQL queries to return data of interest
- Display saved queries inside an SQLView window within the OEDesktop environment
- Create OpenEnterprise context menus with the query that will open other View components, passing parameters from a selected row of the query
- Create queries that will accept parameters passed from other OpenEnterprise menus
- Drag and drop objects as OPC tags from a DOV query directly into a Trend View or Graphics View window.
2 Database Explorer Interface

The Database Explorer's user interface consists of a Menu Bar, Tool Bar and three separate panes, displaying a tree view of connected databases, a list of tables and a list of table attributes.

2.1 Database Tree View Pane

This section displays Databases which have been 'Added' using the Menu Bar option or the Tool bar button. Connected databases are indicated as green squares. Databases that the local machine has not been able to connect to are indicated as red squares.
2.1.1 Opening the Database tree

A ‘plus’ sign \( + \) to the left of a table indicates that this table is a parent to other tables. These other tables lie at a lower level beneath it, and they are derived from the parent. This means that they ‘inherit’ all of the attributes of their parent table, and add some of their own. This is possible because the OpenEnterprise database is an object oriented database as well as being fully relational. When the plus sign is selected, any tables below it are displayed. A plus sign that has been selected becomes a minus sign \( - \).

2.1.2 Tables

Tables in the OpenEnterprise Database are named with the _Table extension. Tables do not have security on them, and therefore, on systems needing security should not be used as part of OPC strings. Normally, in a security enabled system, only the Administrator user is allowed access to tables.

2.1.3 Views

Views in the OpenEnterprise Database do not have the _Table extension. They are created as a user logs in, and only objects having an AccessArea attribute associated with that user are shown in it. Views do not have a plus sign to the left of them, since nothing is derived from them.

In order to implement Workstation security, all Graphic and Trend View files should be configured so that OPC tags access these database views, not the corresponding tables. SQL queries created by the Database Object Viewer for displaying in the OEDesktop should also be configured to query database views, not the underlying Tables. Providing the user has write access to the tables, any writes made on the views are replicated in the tables.

2.1.4 Quickly Viewing all Objects in a selected Table

A double left mouse click on a table within the Database pane opens an instance of the Database Object Viewer and loads the .dbx file contained in the sample .dbx files with the same name as the table selected. The queries within these files retrieve all attributes of all the objects within the table. If the number of objects returned by the query is large then the user is alerted to this possibility by a message box.

Selecting the [No] button on the warning message box will open the DOV without running the query.

In order to protect the source database from killer queries the Database Explorer differentiates between realtime and historical queries.
If you double-click on an historical table or view for which a .dbx file does not already exist then the query will still be constructed, but will not be run automatically. Firstly, you will see the same message as above. If you select [Yes], then a further message will be displayed making the situation doubly clear.

To avoid the possibility of initiating a killer query, it is advisable to select [No] on this dialog. The dialog will close without the query being run, but the Database Object Viewer will remain open with the non-conditional query defined. You should then add conditions to the query, prior to executing and/or saving it.

2.1.5 Context Menus

A right click on a database or table within the Database pane invokes a context menu. The available options are slightly different depending on whether the selection is a database or a table.

2.1.6 Database Context Menus

When a database has been selected from the Database Tree view pane, and the right mouse button is selected, this context menu becomes available.

2.1.6.1 Database Context Menu
2.1.6.2 Connect

This is only enabled if the Database Explorer is not yet connected to the listed Database. If selected, the Database Explorer will attempt to connect to the database.

2.1.6.3 Disconnect

This is only enabled if the Database Explorer is currently connected to the selected Database. Selection of this option will cause the Database Explorer to disconnect from the highlighted database.

2.1.6.4 Remove From Hierarchy

This option will disconnect from the selected database and remove it from the Database Tree View Pane.

2.1.6.5 Search for Table

Selection will open a simple dialog with a text entry field.

The user types in the name of a table and selects the [OK] button. If the table exists in the database it is placed in the Table pane.

2.1.6.6 Search for Attribute

To search for an attribute the user is presented with a dialog containing a text entry field. The user types in the name of the attribute to search for and selects the [OK] button.

A warning message will appear that the search could possibly impact on the performance of the Server. If the user selects the [OK] button, all of the tables containing the specified attribute will be placed into the Tables pane.

2.1.6.7 Search for Primary Key Attribute

To search for a primary key attribute the user is presented with a dialog containing a text entry field. The user types in the name of the primary key attribute to search for and selects the [OK] button.

A warning message will appear that the search could possibly impact on the performance of the Server. If the user selects the [OK] button, all of the tables containing the specified primary key attribute will be placed into the Tables pane.

2.1.6.8 Search for Owned Tables

If selected, this option will cause the Database Explorer to search for tables which have an Owner attribute that matches the name of the currently logged on user.

By default, the owner of every table is the SYSTEM user. A suitable message will confirm if there are no tables that are owned by the current user.

2.1.7 Table Context Menus

When a table is selected from the Database Tree view pane, and the right mouse button is selected, this context menu becomes available.
2.1.7.1 Search for Attribute

Database Explorer will search the selected table for the attribute entered into the dialog's text entry field. If the attribute is found in the table, the table will be placed into the Table pane.

2.1.7.2 Search for Primary Key Attribute

Database Explorer will search the selected table for the suggested primary key attribute entered into the dialog's text entry field. If the attribute is found, and it is a primary key in the table, the table will be placed into the Table pane.

Hint: Selecting the table will automatically place all of its attributes in the Attribute pane. Click on the Attribute pane and then select the View-Detail menu option from the Menu bar. One of the columns, which open to the right of each attribute, is called 'Primary Key'. This will show which attribute is the primary key for the table.

2.1.7.3 Configure Content

Selection of this option will display the Attribute Filter dialog - shown also by the Options-Content Attributes item on the Menu bar. This allows the user to enable or disable any attribute type for viewing within the Attributes pane.

2.2 Tables Pane

Displays any tables derived from the table selected in the Database Tree View pane. If a database is selected in the Database Tree View pane, all of it's tables will be displayed here. If a base table or a view is selected in the left hand Database Tree view pane, then no tables are displayed in the tables pane.

In Details mode, the pane will display each derived table as a list, displaying information about each table alongside, such as Depth, Type, Primary Key, Persistent, System and Owner attributes for each table displayed.

Right clicking on an object will display the Context Menu.

2.2.1 Tables Pane Details Mode

If you select a table displayed in the Table Pane, it is possible to place the Tables Pane into Details mode. Do this by either selecting the View-->{Double quoted text}Details menu or the Details button on the toolbar:
Details mode is displayed below. It provides information regarding each table in the pane.

<table>
<thead>
<tr>
<th>Name</th>
<th>Database</th>
<th>Base Table</th>
<th>Depth</th>
<th>Type</th>
<th>Primary Key</th>
<th>Persistent</th>
<th>System</th>
<th>Owner</th>
</tr>
</thead>
<tbody>
<tr>
<td>alamcondition_table</td>
<td>ndb01</td>
<td>alarmcondition_table</td>
<td>L</td>
<td>0</td>
<td>id</td>
<td>Yes</td>
<td>No</td>
<td>SYSTEM</td>
</tr>
<tr>
<td>configurationalarm_table</td>
<td>ndb01</td>
<td>alarmcondition_table</td>
<td>L</td>
<td>0</td>
<td>id</td>
<td>Yes</td>
<td>No</td>
<td>SYSTEM</td>
</tr>
<tr>
<td>digitizationalarm_table</td>
<td>ndb01</td>
<td>alarmcondition_table</td>
<td>L</td>
<td>0</td>
<td>id</td>
<td>Yes</td>
<td>No</td>
<td>SYSTEM</td>
</tr>
<tr>
<td>digitalalarmscondition_table</td>
<td>ndb01</td>
<td>alarmcondition_table</td>
<td>L</td>
<td>0</td>
<td>id</td>
<td>Yes</td>
<td>No</td>
<td>SYSTEM</td>
</tr>
<tr>
<td>fjournalalarmcondition_table</td>
<td>ndb01</td>
<td>alarmcondition_table</td>
<td>L</td>
<td>0</td>
<td>id</td>
<td>Yes</td>
<td>No</td>
<td>SYSTEM</td>
</tr>
</tbody>
</table>

2.2.2 Tables Pane Context Menu

When an object is selected from the Tables Pane, a right click with the mouse reveals a context menu.

2.2.2.1 Search for Attribute

Database Explorer will search the selected table for the attribute entered into the dialog's text entry field. If the attribute is found in the table, the table will be placed into the Table pane.

2.2.2.2 Search for Primary Key Attribute

Database Explorer will search the selected table for the suggested primary key attribute entered into the dialog's text entry field. If the attribute is found, and it is a primary key in the table, the table will be placed into the Table pane.

Hint: Selecting the table will automatically place all of its attributes in the Attribute pane. Click on the Attribute pane and then select the View-Detail menu option from the Menu bar. One of the columns, which open to the right of each attribute, is called 'Primary Key'. This will show which attribute is the primary key for the table.

2.2.2.3 Configure Content

Selection of this option will display the Attribute Filter dialog - shown also by the Options-Content Attributes item on the Menu bar. This allows the user to enable or disable any attribute type for viewing within the Attributes pane.

2.2.2.4 Down One Level

This option is enabled when any object is selected from the Databases pane or the Tables pane. It takes the user down one level from the selected object.

2.2.2.5 Up One Level

This option takes the user up one level from the selected object in the OpenEnterpriseDatabases or Tables pane.
2.2.2.6 Help

Selecting this option will open the Schema Help file at the correct table and attribute (if an attribute has been selected from the Attributes Pane). If there is no help for the selected table or attribute, a message will explain this to the user.

2.3 Attributes Pane

This pane displays the attributes of any table selected from the Database pane or the Tables pane. There is no context menu available on this pane.

If the Attributes pane is in Details mode, then it will display the Name, Table, Type, Primary Key, Foreign Key, Not-Null, Persistent, Hidden and Array attributes of the selected table in this pane.

Right clicking on an attribute will display the Context Menu.

2.3.1 Attributes Pane Details Mode

If you select an attribute displayed in the Attributes Pane, it is possible to place the Attributes Pane into Details mode. Do this by either selecting the View-->Details menu or the Details button on the toolbar:

```
Details mode is displayed below. It provides information regarding each attribute in the pane.
```

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Database</th>
<th>Type</th>
<th>Primary Key</th>
<th>Foreign Key</th>
<th>Not-Null</th>
<th>Persistent</th>
<th>Hidden</th>
<th>Array</th>
</tr>
</thead>
<tbody>
<tr>
<td>accessarea</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>char</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>alarmaction</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>char</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>alarmactionenable</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>bool</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>alarmactionoptions</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>integer</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>alarmactiontriger</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>bool</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>alarmconditiontype</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>char</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>alarmcurrent</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>bool</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>alarmfrequency</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>integer</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>audiosound</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>char</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>audiosoundrepeats</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>integer</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>condition</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>integer</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>conditiondirection</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>integer</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>firstalarmcondition</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>integer</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>groupalarmcount</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>integer</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>helpcount</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>char</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>id</td>
<td>alarmcondition_table</td>
<td>rhsb1</td>
<td>integer</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

2.3.2 Attributes Pane Context Menu

When an object is selected from the Attributes Pane, a right click with the mouse reveals a context menu containing the single option Help.

```
accessarea
alarmaction
alarmationenable
alarmationoptions
alarmactiontriger
alarmcurrent
Help
alarcondition
alarmhibit
```

This opens the Schema Help file at the correct table and attribute, providing context sensitive help on each attribute in the table. If there is no help for the selected attribute, a message is displayed.
2.4 Menu Bar

The menu bar provides access to all the features of the Database Explorer.

2.4.1 File Menu

The File Menu in the context of the Database Explorer provides access and connections to OpenEnterprise databases.

2.4.1.1 Add Database Dialog

The ‘Add Database to Hierarchy’ Dialog enables the user to connect to any OpenEnterprise Database that is reachable from the Workstation’s network domain. Click on the Database Address field in the image below for more information on specifying OpenEnterprise Database addresses.
2.4.1.2 Database Address Definition

The name of the available Database must be typed into the 'Database Address' field of the 'Add Database to Hierarchy' Dialog. If it is a local Database, it will consist only of the name or number of the Data Service (by default rtrdb1 or 11001). If it is a remote Database, it will have three components:

- The Server's Domain Name System (DNS) name or IP Address (i.e. oeserve4 or 123:100:0:101);
- A colon to separate the Server's DNS name from its OpenEnterpriseDatabase TCP Service name or number (:)
- The designated OpenEnterpriseData Service name or number (i.e. rtrdb1, 11001).

2.4.1.2.1 Defining the DNS Address

As long as the IP address of the OpenEnterprise Server is known, alternative DNS names may be assigned to OpenEnterprise Servers from Workstations by using the Windows System file called Hosts. This is found in the %WINDIR%\System32\Drivers\Etc directory of the OpenEnterprise Workstation. This should be edited to include the OpenEnterprise Server's IP address, followed by one or a number of names, which can be used as alternative DNS names for the Server, e.g.:

101.100.0.183 pserv1 oeserv1 gsection1 #pserv1

The above configuration would mean that any View on the Workstation could reference the Server as pserv1, oeserv1 or gsection1. The hash mark serves as a comment marker, which here reminds the user that the real DNS name of the Server is pserv1.

2.4.1.2.2 Defining the Data Service Name

The TCP Service name and TCP port number used by the OpenEnterprise Database is defined within a Windows System file called Services. The Services file is found in the %WINDIR%\System32\Drivers\Etc directory of the OpenEnterprise Workstation and Server.

The name given to that port is also the Data_Service name which is used in the Server's Poly.cfg file. From a Windows point of view, it is a port number which is defined by a name which remote clients may use to access the OpenEnterprise Database. By default this port is set to number of 11001 and is given the name rtrdb1.

To create a new data service on the Server, create a new entry in the Services file, assigning it an unused port number. This new data service must then be defined in the Server's Poly.cfg file and the Command Line used to start the database. The same service must be defined in the Service file on any Workstations, and all views must then be configured to connect to this data service rather than the default rtrdb1 data service.

DBE File Menu

2.4.1.3 Connect All

This item connects the local machine to the Databases listed in the Database pane.

2.4.1.4 Disconnect All

This item disconnects the local machine from the Databases listed in the Database pane.
2.4.2 View Menu

This menu enables the user to change the way the Database Explorer interface is displayed, as well as to launch the Database Object Viewer (DOV).

![Database Explorer Menu]

2.4.2.1 View Toolbar

This option enables the user to toggle the visibility of the Database Explorer toolbar.

2.4.2.2 View Status Bar Menu Item

Enables the Status bar to be turned on or off.

2.4.2.3 Large Icons

This option is only enabled if the Tables or Attributes panes are currently selected. If selected it displays the tables or attributes as large icons.

2.4.2.4 Small Icons

This is only enabled if the Tables or Attributes panes are currently selected. If selected it displays the tables or attributes as small icons.
2.4.2.5 List

This is only enabled if the Tables or Attributes panes are currently selected. If selected it displays the tables or attributes as small icons in list form. This is similar to Small Icons display, but it does not enable a vertical scroll bar if the pane will not accommodate the entire list.

2.4.2.6 Detail

This lists the tables or attributes in a report format - i.e. with the name of each object, followed by further details, such as the data type of the attribute, and whether or not it is a foreign key.

2.4.2.7 Down One Level

This option is enabled when any object is selected from the Databases pane or the Tables pane. It takes the user down one level from the selected object.

2.4.2.8 Up One Level

This option takes the user up one level from the selected object in the OpenEnterpriseDatabases or Tables pane.

2.4.2.9 Database Object Viewer

Selection of this option opens the Database Object Viewer.

2.4.3 Options Menu

The Options menu enables you to access the Filter page and also to configure where the default DBX files are situated.

2.4.3.1 Content Attributes

This Dialog enables the user to filter out attributes, or to enable all attributes, including hidden ones.
2.4.3.1.1 Set All Button

Selection of this button will check all of the boxes on the Global Filter Dialog, and will cause every type of attribute found in the selected Table to be displayed in the attribute Window, or the on Attribute tab of the Database Object Viewer.

2.4.3.1.2 Clear All Button

Selection of this button will clear every check box on the Global Filter Dialog. This means that no attributes at all will be displayed within the Attribute Pane of the Database Explorer interface, or the Available Attributes pane on the Attributes tab of the Database Object Viewer.

2.4.3.1.3 Include String

If this box is checked, then the Attribute Pane will display all String attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.4 Include Bool

If this box is checked, then the Attribute Pane will display all Boolean attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.5 Include Integer

If this box is checked, then the Attribute Pane will display all Integer attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.6 Include Real

If this box is checked, then the Attribute Pane will display all Real attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.7 Include Time Date

If this box is checked, then the Attribute Pane will display all Time/Date attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.
2.4.3.1.8 Include Primary Key

If this box is checked, then the Attribute Pane will display the Primary Key of the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.9 Include Foreign Keys

If this box is checked, then the Attribute Pane will display any Foreign Keys from the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.10 Include Not Keys

If this box is checked, then the Attribute Pane will display any attributes that are not Primary or Foreign Keys from the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.11 Include Nullable

If this box is checked, then the Attribute Pane will display all attributes that can have a Null value found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.12 Include Not Nullable

If this box is checked, then the Attribute Pane will display all attributes that may not have a Null value from the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.13 Include Persistent

If this box is checked, then the Attribute Pane will display all attributes which have been defined as Persistent found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.14 Include Not Persistent

If this box is checked, then the Attribute Pane will display all attributes which have not been defined as Persistent found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.15 Include Hidden

If this box is checked, then the Attribute Pane will display all attributes which have been defined as Hidden found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.1.16 Include Not Hidden

If this box is checked, then the Attribute Pane will display all attributes which have not been defined as Hidden found in the selected Table. Unchecking means that none of this attribute type will be displayed.

2.4.3.2 Default DBX Files

This menu item enables the user to change the default .dbx file directory. This is the directory where the default .dbx sample files are stored.
Remote Automation Solutions
Website: www.EmersonProcess.com/Remote
2.4.4.2 Close All Windows

This option closes all DOV windows which are open.

2.4.5 The Help Menu

The Help menu provides access to this Help file, and also this About box, which gives helpful information on the version and build number of OpenEnterprise you are using, and also support contact information.

2.5 The Status Bar

The Status Bar displays extra information about any database or table selected from the Database Tree View pane or Tables pane. If the selected item is a database it displays the number of tables in the database. If the selected item is a table it displays how many derived tables it has, and how many of its attributes are it's own plus how many attributes it has in total.

2.6 Toolbar

The toolbar provides quick access via its icons to many of the functions which are also available from menu items.
2.6.1 Database List

This drop down list displays all OpenEnterprise Databases that have been added to the Database Tree View Pane.

2.6.2 Up One Level Button

This button takes the user up one level from the selected object in the OpenEnterprise Databases or Tables pane.

2.6.3 Add Database Button

This button opens the 'Add Database Dialog' for adding a new OpenEnterprise Database to the Database Tree View Pane.

2.6.4 Open DOV Button

This button opens an instance of the Database Object Viewer (DOV).

2.6.5 Large Icons Button

This button is only enabled if the Tables or Attributes panes are currently selected. If selected it displays the tables or attributes as large icons.

2.6.6 Small Icons Button

This is only enabled if the Tables or Attributes panes are currently selected. If selected it displays the tables or attributes as small icons.

2.6.7 List Button

This is only enabled if the Tables or Attributes panes are currently selected. If selected it displays the tables or attributes as small icons in list form. This is similar to Small Icons display, but it does not enable a vertical scroll bar if the pane will not accommodate the entire list.

2.6.8 Details Button

This lists the tables or attributes in a report format - i.e. with the name of each object, followed by further details, such as the data type of the attribute, and whether or not it is a foreign key.
3 The Database Object Viewer

The Database Object Viewer is similar in appearance to the Database Explorer, but has different tabs. These enable the user to configure and save queries for use within the OEDesktop.

3.1 File Menu

This menu enables you to open, close and save files created with the Database Object Viewer (.DBX files).
3.1.1  New

Clears any query settings already configured and initiates a new query. A warning message requests if the user wishes to save the current query before resetting the DOV.

3.1.2  Open

Opens a .dbx File selection dialog. This will load the selected 'dbx file into the DOV.

3.1.3  Close

Closes the current query. There will be a prompt to save any changes.

3.1.4  Save

Saves a modified .dbx file.

3.1.5  Save As

Opens a 'Save as' File dialog. The user must enter a name for the file and select the [Save] button.

The file will be saved with a .dbx extension. This type of file can be loaded into the DOV later, or if required, into an SQL Viewer window (see the SQL Viewer Help File for details).

3.1.6  Run

Runs the currently configured query. Results will be displayed in the 'Objects' tab.
3.1.7 Exit

Exits the DOV. The user will be prompted to save if changes have been made to the query.

3.2 Options Menu

This menu provides useful options to control how the Database Object Viewer (DOV) will behave.

3.2.1 Read Only

Saves the query as a read only .dbx file. When it is next opened in the DOV the Options-Active Query and Options-Custom Data String Menu bar items will be disabled, as well as the corresponding buttons on the Toolbar.

The Filter Tab will also be disabled, such that the attribute filter cannot be changed. Reselecting the Options-Read Only Menu item will uncheck the item, and the above items will be re-enabled, to allow the query to be modified.

3.2.2 Active Query

Sets the currently configured query to be active when run (i.e. it will continuously update and display changing values).

3.2.3 Custom Data String

Displays the OEMenu editor for configuration of a new OpenEnterprise context menu item.
3.2.4 Tag Format

There are two further options on this menu.

3.2.4.1 OPC

This is the default tag format and as such, any signal objects, which are dragged from the DOV to an OpenEnterprise Trend or OEGraphics display, will insert a correctly formatted OPC tag into the OpenEnterprise Trend or OEGraphics display.

3.2.4.2 DDE

The DDE tag format is used if the user has installed the OpenEnterpriseDDE Server. If this option is checked, and the OpenEnterpriseDDE Server is operational on the local computer, then a ‘drag and drop’ operation from the DOV to a cell in a spreadsheet will result in a DDE tag being inserted into the spreadsheet cell. The DDE Server will continuously display the current value of the signal in the spreadsheet cell.

3.2.5 Printer Properties

Displays the Printer Properties dialog. This enables the setting of headers and footers, and foreground and background colors for printing the query.

3.2.6 Display Properties

**Display Properties**

- **Background Colour**: Displays the currently selected background color for the Object tab or SQL View window (if the query is saved and loaded into an SQL View window).

- **Foreground Colour**: Displays the currently selected foreground, or pen color for the Object tab window or SQL View window (if the query is saved and loaded into an SQL View window).

- **Color Browse Buttons**: These buttons open a color selection dialog so that a new color can be selected for the foreground or background.
3.2.6.4 Hide Column Headings

If this box is checked, the column headings will not be displayed in the Object window or the SQL View window (if the query is saved and loaded into an SQL View window).

3.2.6.5 Disable Message Boxes

If checked, any message boxes which may be displayed as the query runs will be disabled.

3.3 Query Menu

This menu enables you to both run and stop queries that have been configured.

![Database Object View Interface](image)

3.3.1 Apply

Runs the currently configured query within the DOV. When a query is run the Objects tab is automatically displayed.

3.3.2 Stop

This option is only enabled if the query is being run in active mode. When selected the active query stops, and the Objects tab becomes blank.

3.4 Help Menu

The Database Object Viewer Help menu provides access to this help file and also to the About dialog, which provides information about the OpenEnterprise version number, and contact details.

3.5 DOV Status Bar

The status bar displays information about the current query.

3.6 The DOV Toolbar

The toolbar provides quick access to the more important menu commands.
3.6.1 New Query

Clears any query settings already configured and initiates a new query. A warning message requests if the user wishes to save the current query before resetting the DOV.

3.6.2 Open Query

Selection will open a .dbx File selection dialog. This will load the selected ‘dbx file into the DOV.

3.6.3 Close Query

If selected, the current query will be closed. The user will be prompted to save any changes.

3.6.4 Save Query

Saves a modified .dbx file.

3.6.5 Save As

Opens a ‘Save as’ File dialog. The user must enter a name for the file and select the [Save] button.

The file will be saved with a .dbx extension. This type of file can be loaded into the DOV later, or if required, into an SQL Viewer window (see the SQL Viewer Help File for details).

3.6.6 Run a Saved Query

Selecting this button will display an open file selection dialog. The selected .dbx file will be opened and the query will run immediately.

3.6.7 DOV Up One Level

Selection of this button will move the selection in the ‘Available Tables’ pane up one level in the database (i.e. to the parent table of the selection).

3.6.8 Menu Editor

Selecting this button will invoke the Menu Editor. This will enable the user to configure context menu items which will be saved within the .dbx file. See OEMenu Editor Help for more information.

3.6.9 Run Current Query

Selecting this query will run the current query. Results will be displayed in the Objects tab.

3.6.10 Active Query Button

Selecting this button before running a current query will make the query active (i.e. it will continually refresh the values).
3.7 Tables Tab

This tab allows the user to select a table(s) as the target of the query. It is the default tab. Selecting more than one table is not currently recommended.

3.7.1 Available Tables Pane

This acts in the same way as the Database pane in the Database Explorer. When a table is selected, the [Add] button becomes enabled. Selecting the button will insert the selected table into the Selected Tables pane.

3.7.2 Add Button

The [Add] button becomes enabled when a table is selected from the Databases and Tables pane. It inserts tables selected from the Available Tables pane into the Selected Tables pane.

3.7.3 Remove Button

The [Remove] button becomes enabled when a table is selected from the Selected Database pane. It removes tables selected from the Selected Tables pane.

3.7.4 Selected Database

This field displays the currently selected OpenEnterpriseDatabase.

3.7.5 Selected Tables

This pane displays the tables which have been selected as the target for the query.
3.8 Conditions Tab

This tab allows the user to compose one or more conditions for the query. Attributes on which conditions are to be placed are selected. The attribute is added to the 'Condition' field, and the user types in the condition. The condition is then added to the query using the [Update] button.

3.8.1 Auto Run Without Conditions

When checked, the usual warning messages that are displayed if a query has no conditions defined are suppressed.

3.8.2 Available Attributes Pane

This pane displays all of the attributes available within the selected table. When an attribute is selected it may be inserted into the Condition Editing field by selecting the [Add] button.

3.8.3 Add Attribute Button

This button inserts an attribute selected in the Available Attributes pane into the Condition Editing Field.

3.8.4 Update Query Button

Selection places the condition currently in the Condition Editing Field into the Conditions pane. This action incorporates the condition into the query.

3.8.5 Remove Condition Button

Deletes a condition which has been selected from the Conditions pane.
3.8.6 Condition Edit Field

The user must type in a valid condition which will be applied to the query. This is useful for filtering out objects not required in the query. Valid operators are:

- **like** (returns objects which match up to or between the wildcard character(s))
- **not like** (discards objects which match up to or between the wildcard character(s))
- **=** (returns objects which match the condition value exactly)
- **<>** (discards objects which match the given condition value)
- **>** (returns objects which have a value greater than the condition value)
- **<** (returns objects which have a value less than the condition value)

The wildcard operator used in the condition’s value is a ‘%’ sign. The condition value must be surrounded by single quotes.

3.8.7 Edit Attribute Button

Selecting this button inserts a condition selected from the Conditions pane into the Condition Editing Field for modification.

3.9 Parameters Tab

This tab enables the user to give any parameters used in the query a default definition. This tab will only display a parameter if a condition has been entered on the Conditions Tab that contains an alias.
3.9.1 Parameter Name

This field contains the Parameter currently selected from the Parameters list and is not editable. It obtains its value from the Conditions Tab.

Any parameters defined in the conditions on the Conditions tab will be displayed in the Parameter list on this tab. An alias is declared in the condition field on the Conditions tab by enclosing it in double chevrons (e.g. `name like '<<RTU>>:%LEVEL.'`).

3.9.2 Parameter Definition

This text entry field provides the user with the ability to assign a value to the parameter. If a parameter is passed from an OpenEnterpriseView to an SQL View containing this query, the value assigned in this way will be overwritten by the passed parameter.

3.9.3 Parameter List

This displays a list of any aliases (parameters) defined within the Conditions tab.

3.10 Joins Tab

The DOV Joins Tab enables the user to join one or more tables that are related by foreign keys in order to display attributes from different tables in one query result. The Available Attributes list on the Joins tab will only be populated if two or more tables were selected from the Tables tab for inclusion in the query.
3.10.1 Attributes Available for Join Statement

The user must select the attributes from each table which will provide the join part of the SQL Where clause

i.e. select name, value, devicename from table1, table2 where name like 'TANKS%' AND table1.attributename = table2.attributename.

The attributes are presented with the table names followed by a dot, followed by the attributes for the table. Only when the user has specified an attribute from each table will the [Add] button become enabled. When this button is selected the Join condition is placed into the Joins list.

3.10.2 Add Join Button

This button adds selected attributes from the Available Attributes list to the Joins list. The Add button will only become available when there is an attribute from each table selected from the Available Attributes list.

3.10.3 Remove Join Button

Once highlighted, this button removes selected joins from the Joins list.

3.10.4 Joins List

This list shows the Join conditions being applied to the query. Joins may be removed from the list by highlighting them and then selecting the [Remove] button.

3.11 Attributes Tab

This tab enables the user to specify which attributes from the selected table to include in the query results.
3.11.1 Available Attributes

All of the available attributes from the selected table will be displayed here, depending on any filters which may have been applied on the Filter tab. Multiple attributes can be selected by holding down the [Shift] or [Ctrl] keys on the computer keyboard.

3.11.2 Add Attributes Button

Selection of this button, when one or more attributes have been selected in the Available Attributes list will add them to the Selected Attributes list. The query will only display attributes that have been added to the Selected Attributes list.

3.11.3 Remove Attributes Button

This button is enabled when one or more attributes are selected from the Selected Attributes list. If selected, the chosen attributes will be removed from this list.

3.11.4 Remove All Attributes Button

If selected, this button will remove all attributes that have been placed into the Selected Attributes list.

3.11.5 Selected Attributes List

This list displays all of the attributes that have been selected for inclusion in the query's results. Attributes may be moved up and down the Selected Attributes list by selecting and dragging with the mouse to the desired position.
3.11.6  **Toggle Attribute Display**

A check inside the check boxes to the left of the attribute names indicates that the query results will display the attribute. If the check box is empty, the query will return the value of the attribute, but will not display it in the Objects or the SQL Viewer window.

3.11.7  **Row or Cell Selection Buttons**

These buttons determine whether a single attribute or a whole row will be selected when the user clicks on a query object result within the Objects tab or in an SQL Viewer displayed within the OpenEnterpriseDesktop.

3.11.8  **Row Selection**

If this option is selected, when the user selects an object from the query results window (whether that be in the DOV or an SQL View window), the whole row will be highlighted.

3.11.9  **Cell Selection**

If this option is selected, when the user selects an object from the query results window (whether that be in the DOV or an SQL View window), only the actual cell selected will be highlighted, rather than the whole row.

3.11.10  **Dynamic Sort**

If this box is checked, then the saved DBX file can be configured to open sorted on a selected attribute. The sort can be Ascending or Descending. A sort defined here will override any sort defined in the query (found on the SQL Tab). The sort can also be defined as active for an active query, so if any of values in the sorted column change after a refresh, the sort order is also updated.

3.11.11  **Sort Column**

This is a list of the attributes defined in the query. The selected attribute will be the one on which the query is sorted. It will be marked with an upward (ascending) or downward (descending) arrow on the query results page, depending on the direction of the sort.

![Sort Column Example](image)

3.11.12  **Sort Ascending**

Check this box if you want the query to be sorted in ascending order on the selected sort column. Leave it unchecked if you prefer the query to be sorted in descending order.

3.11.13  **Active Query Support**

Check this box if you have an active query and want the sort order to be refreshed whenever the query is refreshed.

3.12  **SQL Tab**

This tab enables the user to view and/or modify the SQL statement used in the query.

Remote Automation Solutions
3.12.1 SQL Statement Field

The SQL Statement field displays the query that has been built from the configuration on the other tabs. It is greyed-out and non-editable until the [Edited] button is selected.

3.12.2 Edited Button

If this button is selected, the SQL Statement field becomes editable. The user may then type in an SQL statement, or modify the generated statement.

3.12.3 Generated Button

If this button is checked, the SQL Statement field is greyed-out and is non-editable. It will display the SQL statement which has been generated automatically from the table and attribute selection, as well as any conditions that have been defined on the Conditions tab.

3.13 Filter Tab

This tab enables the user to select or deselect attribute types for inclusion / exclusion from the configured query. It is the same as the Database Explorer Global Filter dialog except that the filters apply to the Available Attributes pane on the Database Object View’s Attributes tab.
3.13.1 Include String

If this box is checked, then the Attribute Pane will display all String attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.2 Include Bool

If this box is checked, then the Attribute Pane will display all Boolean attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.3 Include Integer

If this box is checked, then the Attribute Pane will display all Integer attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.4 Include Real

If this box is checked, then the Attribute Pane will display all Real attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.5 Include Time Date

If this box is checked, then the Attribute Pane will display all Time/Date attributes found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.6 Include Primary Key

If this box is checked, then the Attribute Pane will display the Primary Key of the selected Table. Unchecking means that none of this attribute type will be displayed.
3.13.7 Include Foreign Keys

If this box is checked, then the Attribute Pane will display any Foreign Keys from the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.8 Include Not Keys

If this box is checked, then the Attribute Pane will display any attributes that are not Primary or Foreign Keys from the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.9 Include Nullable

If this box is checked, then the Attribute Pane will display all attributes that can have a Null value found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.10 Include Not Nullable

If this box is checked, then the Attribute Pane will display all attributes that may not have a Null value from the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.11 Include Persistent

If this box is checked, then the Attribute Pane will display all attributes which have been defined as Persistent found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.12 Include Hidden

If this box is checked, then the Attribute Pane will display all attributes which have been defined as Hidden found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.13.13 Include Not Hidden

If this box is checked, then the Attribute Pane will display all attributes which have not been defined as Hidden found in the selected Table. Unchecking means that none of this attribute type will be displayed.

3.14 Time Zone Tab

This tab enables the user to change the Time Zone used by the DOV. All date/time fields will display the current time in the selected time zone.
3.14.1 Use Time Zone Button

When this button is checked the Time Zone list becomes enabled so that the user can select a time zone. If the button is not checked, time-date fields in the query will be displayed in GMT.

3.14.2 Time Zone List

Clicking on this item reveals a list of Time Zones for selection. Any time-date fields returned by the query will be displayed in the time indicated by the selected time zone.

3.15 Objects Tab

This tab displays the results of the query when it is run.
3.15.1 Queried Objects List

The list of queried objects are displayed here. Only the attributes selected and ticked for display on the Attributes tab are shown.

If the query was configured to be active, the values should be updating regularly. The number of objects returned by the query should be displayed in the Status bar.
4 Index

A
Active Query.............................................. 26
Active Query Button................................. 30
Add Attribute Button................................. 32
Add Button ................................................ 30
Add Database ........................................... 12
   Hierarchy Dialog.................................... 12
Add Database Button................................. 21
Add Join Button........................................ 34
Apply ......................................................... 28
   Attribute ............................................. 6, 7, 9
   Search .................................................. 6
   Table Object Search............................. 7, 9
Attribute Tab Add Attributes Button .......... 35
Attribute Tab Remove Attributes Button ... 36
Attributes Available .................................. 34
   Join Statement.................................... 34
Attributes Tab......................................... 35
   Attributes Tab Remove All Attributes Button36
Available Attributes ................................ 34
   Available Attributes Pane..................... 32
   Available Tables Pane......................... 30
B
Background Color ..................................... 27
C
Cell Selection .......................................... 36
   Cell Selection Buttons.......................... 36
Clear All Button ......................................... 16
Close ....................................................... 24
   Close All Windows............................... 20
   Close Query ....................................... 29
Color Browse Buttons............................... 27
   Condition Edit Field ......................... 32
   Conditions Tab .................................. 31
Connect .................................................... 6
   Connect All....................................... 13
   Custom Data String.............................. 26
D
Database Explorer Interface..................... 3
   Database List...................................... 21
   Database Object Context Menus.............. 5
   Database Object View Interface.............. 23
   Database Object Viewer........................ 15
   DBE Attributes Pane............................ 10
   DBE Database Tree View Pane................. 4
   DBE File Menu...................................... 11
   DBE Help Menu..................................... 20
   DBE Menu Bar...................................... 11
   DBE Options Menu................................ 15
   DBE Tables Pane.................................... 8
   DBE Toolbar ........................................ 21
   DBE View Menu..................................... 14
   DBE Window Menu................................. 19
   Default DBX Files................................. 18
   Detail............................................... 15
   Details Button..................................... 22
   Disable Message Boxes........................ 27
   Disconnect......................................... 6
   Disconnect All..................................... 14
   Display Properties Dialog..................... 27
   DOV Help Menu..................................... 28
   DOV Status Bar..................................... 28
   DOV Toolbar........................................ 28
   DOV Up One Level.................................. 29
   Down One Level.................................... 9, 15
E
   Edit Attribute Button........................... 32
   Edited Button....................................... 38
   Editor ............................................... 38
   Exit................................................... 25
F
Filter Tab............................................... 38
   Foreground Colour............................... 27
G
   Generated Button................................. 38
   Global Filter Dialog.............................. 16
H
Small Icons........................................ 15
Small Icons Button ......................... 21
SQL Statement Field...................... 38
SQL Tab........................................... 37
Status Bar..................................... 20
Stop.............................................. 28

T
Table ............................................ 6
Search ....................................... 6
Table Object Configure Content ...... 8, 9
Table Object Context Menus.......... 7
Table Object Search ................. 7, 9
Attribute ................................... 7, 9
Primary Key Attribute.................. 7, 9
Tables Tab ................................... 30
Tag Format ................................... 26
Time Zone List ............................. 41
Time Zone Tab ............................. 41
Toggle Attribute Display............... 36

U
Update Attribute Button ............... 32
Use Time Zone Button .................. 41

V
View Status Bar Menu Item .......... 14
View Toolbar Menu Item ............... 14
DISCLAIMER

Bristol, Inc., Bristol Babcock Ltd, Bristol Canada, BBI SA de CV and the Flow Computer Division, are wholly owned subsidiaries of Emerson Electric Co. doing business as Remote Automation Solutions ("RAS"), a division of Emerson Process Management. ROC, FloBoss, ROCLink, Bristol, Bristol Babcock, ControlWave, TeleFlow and Helicoid are trademarks of RAS. AMS, PlantWeb and the PlantWeb logo are marks of Emerson Electric Co. The Emerson logo is a trademark and service mark of the Emerson Electric Co. All other marks are property of their respective owners.

The contents of this publication are presented for informational purposes only. While every effort has been made to ensure informational accuracy, they are not to be construed as warranties or guarantees, express or implied, regarding the products or services described herein or their use or applicability. RAS reserves the right to modify or improve the designs or specifications of such products at any time without notice. All sales are governed by RAS' terms and conditions which are available upon request. RAS does not assume responsibility for the selection, use or maintenance of any product. Responsibility for proper selection, use and maintenance of any RAS product remains solely with the purchaser and end-user.

Engineered and supported by:

Remote Automation Solutions,

Blackpole Road, Worcester, WR3 8YB, UK

Registered office: Meridian East, Leicester, LE19 1UX

Registered in England and Wales, Registration No. 00671801

VAT Reg No. GB 705 353 652